
Cascading Style Sheets 
Written by: Steven D. Anderson, Ph.D. 

 
Resources 
 
WestCIV Complete Style Guide: http://www.westciv.com/style_master/academy/css_tutorial/index.html 
Tizag.com: http://www.tizag.com/cssT 
Tizag.com CSS Reference: http://www.tizag.com/cssT/reference.php 
 

A Style 
 

 
 

Internal, External and Inline Style Sheets 
 
Inline Style Sheets 
 
* Style information goes around text, much like the old-fashioned <FONT> tags 
* Like the old <FONT> tags, the style only applies to that text 
* This is the weakest implementation of style sheets 
* Most commonly used when using layers (<DIV> tag).  (More on that later). 
 
* Create a new file in Dreamweaver and call it cssinline.html 
* In “Code View”, insert the text below 
 

cssinline.html 
 
<span style="color: red; font-family: 'Arial,Helvetica', sans-serif "> This text is styled in red with 
Arrial or Helvetica font, if available.</span>  
 
* Save the file cssinline.html and check it in a browser. 
 
Internal Style Sheets 
 
* Also called an “Embedded” Style Sheet 
* Style information goes in the <HEAD> section of the document 
* Styles are available to use on other text in this document 
* Styles ARE NOT available for use in other documents 
 



* Create a new file in Dreamweaver and call it cssinternal.html 
* In “Code View”, insert the text on the left below 
 

cssinternal.html 
<html> 
<head> 
<title>Style Sheets </title> 
<style type="text/css"> 
.large24 { 
 font-size: 24px; 
 font-family: Arial, Helvetica, sans-serif; 
} 
</style> 
</head> 
</body> 
<span class="large24">This text is styled as part of an 
Internal Style Sheet.</span> 
</body> 
</html> 

 
 
 
  This specifies the style information for 
.large24 
 
 
 
 
 
  This calls on the large24 style for the 
selected text 

 
* Save the file cssinternal.html and check it in a browser. 
 
External Style Sheets 
 
The External CSS File 
* An external file holds the style information (i.e. stylesheet.css) 
* The HTML file just contains a link to that style sheet 
* The styles contained in the external style sheet can be used by all of the files on your site 
 
* In Notepad (PC) or SimpleText (Mac), create a new file called stylesheet.css.  
 - Save it in the same folder as your other HTML files for this lesson. 
* Insert the text below 

 
stylesheet.css 

.large24 { 
font-size: 24px; 
font-family: Arial, Helvetica, sans-serif; 
} 

* Save the file stylesheet.css 
The HTML File 
* Create a new file in Dreamweaver and call it cssexternal.html 
* In “Code View”, insert the text on the left below 

 
 
 
 



cssexternal.html 
<html> 
<head> 
<title>Style Sheets</title> 
<link href="stylesheet.css" rel="stylesheet" 
type="text/css"> 
</head> 
<body> 
<span class="large24">This text is styled as part 
of an External Style Sheet.</span> 
</body> 
</html> 

 

 
 
 
  This connects the HTML file to the CSS file 
 
 
 
  This calls on the large24 style from the 
external style sheet 

 
* Save the file cssexternal.html and check it in a browser. 
 
Why are they Called Cascading? 
 
* A web page gets it style information in the following order of priority: 
1). Inline: (Overrides Internal and External) 
2). Internal: (Overrides External) 
3). External 
 
* You can specify styles that will apply to all of the pages on your site in an External Style Sheet, and 
then override them with Internal or Inline Styles when you need to make exceptions to those styles.  
 
 

Kinds of Styles 
 
*** NOTE: For these examples, we’ll use an Internal Style Sheet, placing the CSS in the 
<HEAD> section of the document 
 
Redefining an HTML Tag 
 
* So far we’ve been applying the kind of CSS style we’ll cover in #2 below, a Class.   
* Another powerful way to use CSS is to re-define a tag 
* If the style information get removed, the tag goes back to normal 
* It maintains the tags original properties, i.e. an <H3> tag always puts a paragraph-like break after it 
 
* Create a new file in Dreamweaver and call it redefinetag.html 
* In “Code View”, insert the text on the left below 
 
 
 
 
 



redefinetag.html 
<html> 
<head> 
<title>Style Sheets </title> 
<style type="text/css"> 
h3 { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 24px; 
 font-weight: bold; 
} 
h4 { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 18px; 
 font-weight: bold; 
} 
</style> 
</head> 
</body> 
<H3>This is H3 Text</H3> 
<H4>This is H4 Text </H4> 
</body> 
</html> 

 
 
 
 
  This specifies the style information for 
the tags <H3> and <H4> 
 
 
 
 
 
 
 
 
 
  This calls on the <H3> style 
  This calls on the <H4> style 

 
* Save the file redefinetag.html and check it in a browser. 
 
Class 
 
* Starts with a period (i.e. .large24) 
* You get to name your own style 
* There are two ways to apply: 

1. Tags 
- Tag maintains its original properties, but ADDS properties to the tag 

2. Selections of Text  
- Creates a <span> tag 

 
1. Class Applied to a Tag 
* We will apply the large24 class to the <P> tag 
 
* Create a new file in Dreamweaver and call it classtag.html 
* In “Code View”, insert the text on the left below 
 
 
 
 
 
 
 



classtag.html 
<html> 
<head> 
<title>Style Sheets </title> 
<style type="text/css"> 
.large24 { 
font-size: 24px; 
font-family: Arial, Helvetica, sans-serif; 
} 
</style> 
</head> 
</body> 
<p class="large24">This style is applied to the 
entire tag.</p> 
</body> 
</html> 

 
 
 
 
  This specifies the style information for 
.large24 
 
 
 
 
 
  This calls on the large24 style for the selected 
<P> tag 

 
* Save the file classtag.html and check it in a browser. 
* We could have more than one class of <P>.  Another paragraph could use a different style. 
 
2. Class Applied to a Selection of Text: <span> 
* We will apply the large24 class to selected text 
 
* Create a new file in Dreamweaver and call it classselection.html 
* In “Code View”, insert the text on the left below 
 

classselection.html 
<html> 
<head> 
<title>Style Sheets </title> 
<style type="text/css"> 
.large24 { 
font-size: 24px; 
font-family: Arial, Helvetica, sans-serif; 
} 
</style> 
</head> 
</body> 
<p>This style is applied <span class="large24">only 
to a selection of text</span> within this paragraph.</p> 
</body> 
</html> 

 
 
 
 
  This specifies the style information for 
.large24 
 
 
 
 
 
  This calls on the large24 style for the 
selected text 

 
* Save the file classselection.html and check it in a browser. 
 
 
 
 



Advanced CSS Selectors 
 
* There are 4 ways to utilize Advanced CSS Selectors: 

1. Groups of Tags 
2. Contextual Selectors 
3. Link Pseudo Class Selectors  
4. IDs 

 
1. Groups of Tags 
* We will apply the blue color to <H1>, <H2>, <H3> and <H4> tags. 
* We will allow <H4> to additionally have a Courier font. 
* We do this in cases where we want multiple tags to have the same properties and don’t want to have to 
specify them in each style rule.  
 
* Create a new file in Dreamweaver and call it selectorsgroup.html 
* In “Code View”, insert the text on the left below 
 

selectorsgroup.html 
<html> 
<head> 
<title>Style Sheets </title> 
<style type="text/css"> 
h1, h2, h3, h4 { 
 color: blue; 
} 
h4 { 
 font-family: Courier, Courier New; 
} 
 
</style> 
</head> 
</body> 
<H3>This is H3 Text</H3> 
<H4>This is H4 Text </H4> 
</body> 
</html> 

 
 
 
 
  This specifies the style information for 
<H1>, <H2>, <H3> and <H4> tags 
** NOTE: Tags are separated by a COMMA 
 
 
 
 
 
 
  Both <H3> and <H4> will be blue 
  <H4> will also have a Courier font face 

 
* Save the file selectorsgroup.html and check it in a browser. 
 
2. Contextual Selectors 
* Used when you want to style a particular combination of tags in a certain order 
* We will apply a green color and Courier text whenever a <TD> is followed by a link <A HREF> 
 - This example shows a way to make links within a table look different from other links. 
 
* Create a new file in Dreamweaver and call it selectorscontextual.html 
* In “Code View”, insert the text on the left below 
 



selectorscontextual.html 
<html> 
<head> 
<title>Style Sheets </title> 
<style type="text/css"> 
td a { 
 color: #00CC00; 
 font-family: "Courier New", Courier, mono; 
} 
</style> 
</head> 
</body> 
<table width="100%"  border="1"> 
  <tr> 
    <td> 
         <a href="about.html">Here is a link</a> 
    </td> 
  </tr> 
</table> 
</body> 
</html> 

 
 
 
 
  This specifies the style rules for a 
situation where a <TD> is followed by a link 
** NOTE: Tags are separated by a SPACE 
 
 
 
 
 
  Here is <TD> followed by a link 

 
*** NOTE: The tags must be used in this order.  If we had specified instead bold followed by italic, the 
tags would have to be <B><I>Text here</B></I>, not <I><B>Text here<B></I> 
 
* Save the file selectorscontextual.html and check it in a browser. 
 
3a. Link Pseudo Class Selectors (Redefining Links) 
* Allows you to redefine the <a> tag. 
* Allows a rollover effect with a:hover 
 
* Create a new file in Dreamweaver and call it selectorspseudo1.html 
* In “Code View”, insert the text on the left below 
 

selectorspseudo1.html 
<html> 
<head> 
<title>Style Sheets </title> 
<style type="text/css"> 
a:link { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 
 color: #0000FF; 
 text-decoration: none; 
} 
a:visited { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 
 color: #4444FF; 

 
 
 
 
  This specifies the style information for a 
links, visited links, active links and for when 
the mouse hovers over a link. 
 
Tags must be in this order: 
- link 
- visited 
- hover 
- active 



 text-decoration: none; 
} 
a:hover { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 
 color: #0000FF; 
 text-decoration: underline; 
} 
a:active { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 
 color: #4444FF; 
 text-decoration: none; 
} 
</style> 
</head> 
</body> 
<a href="about.html">Click here</a> 
</body> 
</html> 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  A standard link 

 
* Save the file selectorspseudo1.html and check it in a browser. 
 
3b. Link Pseudo Class Selectors (Different Links for Different Purposes) 
* Allows you to create different types of links for different purposes 
 
* Using the file selectorpseudo1.html, re-save it as selectorspseudo2.html 
* In “Code View”, add the text in orange below 
 

selectorspseudo2.html 
<html> 
<head> 
<title>Style Sheets </title> 
<style type="text/css"> 
a:link { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 
 color: #0000FF; 
 text-decoration: none; 
} 
a:visited { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 
 color: #4444FF; 
 text-decoration: none; 
} 
a:hover { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 color: #0000FF; 
 text-decoration: underline; 
} 
a:active { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 
 color: #4444FF; 
 text-decoration: none; 
} 
a.lesson:link { 
 font-family: Courier, Courier New; 
 font-size: 11px; 
 color: #00DD00; 
 font-weight: bold; 
 text-decoration: none; 
} 
 
a.lesson:visited { 
 font-family: Courier, Courier New; 
 font-size: 11px; 
 color: #00DD00; 
 font-weight: bold; 
 text-decoration: none; 
} 
 
a.lesson:hover { 
 font-family: Courier, Courier New; 
 font-size: 11px; 
 color: #00AA00; 
 font-weight: bold; 
 text-decoration: underline; 
} 
 
a.lesson:active { 
 font-family: Courier, Courier New; 
 font-size: 11px; 
 color: #00DD00; 
 font-weight: bold; 
 text-decoration: underline; 
} 
</style> 
</head> 
</body> 
<a href="about.html">Here is the regular link</a><br /> 
<a class ="lesson" href="about.html">Here is a 
different type of link</a> 
</body> 
</html> 

 
 
 
 
 
 
 
 
  This section specifies styles for 
another type of link we’ll call lesson 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  The standard link 
  The different type of link 

 
* Save the file selectorspseudo2.html and check it in a browser. 



4. IDs 
* Starts with a pound sign (i.e. .#header) 
* Used to identify objects on a page 
* Can only be used once on a page 
* Often used to ID layers or images so they can be tracked 
 
* Create a new file in Dreamweaver and call it selectorsid.html 
* In “Code View”, insert the text on the left below 
 

selectorsid.html 
<html> 
<head> 
<title>Style Sheets </title> 
<style type="text/css"> 
#header { 
 position: relative; 
 visibility: visible; 
 z-index: 1; 
 background-color: #000000; 
 color: #99FF99; 
} 
</style> 
</head> 
</body> 
<p id="header">This text can only be used once on 
this page.</p></body> 
</html> 

 
 
 
 
  This specifies the style information for 
the header ID 
 
 
 
 
 
 
 
  Here is <P> with an ID of “header” 

 
*** This is mainly used for keeping track of layers. <DIV> (More on that to come) 
 
* Save the file selectorsid.html and check it in a browser. 
 
 
Layout with CSS 
 
Layout with a Container DIV and “Float” 
 
Example: http://streaming.smad.jmu.edu/smad404/lessons/css/floatlayout.html 
(Notice that the “Right Layer” is allowed to shrink or grow, depending on how much text is in the layer). 
 
Dreamweaver does not create layers like this. Absolute positioning must be deleted in code view, and 
float:left; must be added. 
 
* Create a new file in Dreamweaver and call it floatlayout.html 

floatlayout.html 
<style type="text/css"> 
body { 

The CSS 
 



 margin-left: 0px; 
 margin-top: 0px; 
 margin-right: 0px; 
 margin-bottom: 0px; 
} 
#container { 
 position: relative; 
 margin: 0 auto; 
 width: 770px; 
} 
#toplayer { 
 float:left; 
 left: 0px;  
 top: 0px;  
 width: 770px;  
 height: 100px;  
 z-index: 2;  
 background-color: #99CCFF; 
} 
#leftlayer { 
 padding: 0 0 0 0;  
 margin: 0 0 0 0;  
 float: left; 
 width: 170px;  
 z-index: 3;  
 background-color: #FF99FF; 
} 
#rightlayer { 
 padding:0 0 0 0;  
 margin:0 0 0 0;  
 float:left; 
 width:600px;  
 z-index: 4;  
 background-color: #66FFFF; 
} 
#bottomlayer { 
 padding:0 0 0 0;  
 margin:0 0 0 0;  
 float:left; 
 width:770px; 
 height:113px; 
 z-index:5; 
 background-color: #FFFFCC; 
} 
</style> 
 
<div id="container"> 
      <div id="toplayer"><p>This is the Top    
      Layer.</p></div> 
      <div id="leftlayer"><p>This is the Left  
      Layer.</p></div> 

 
 
 
 
  This is the “container” DIV that allows the 
whole layout to be constrained to 770 pixels 
width. It is also horizontally centered. Do NOT 
use a height declaration. 
 
 
  No relative or absolute positions are given, 
just a float property. 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
  
 
 
 
 
 
 
 
  
 
 
 
 
 
 
The HTML 
 



      <div id="rightlayer"> 
      <p> 
      This is the Right Layer. This is the Right Layer. 
      This is the Right Layer. This is the Right Layer.  
      This is the Right Layer. This is the Right Layer. 
      This is the Right Layer. This is the Right Layer.  
      This is the Right Layer. This is the Right Layer. 
      </p> 
      </div> 
      <div id="bottomlayer">This is the Bottom  
      Layer.</div> 
</div> 
 
* Save the file floatlayout.html and check it in a browser.  
 

• Add content to the “Right Layer” to see how it can expand and push the “Bottom Layer” down the 
page.  

 
(Note: The problem with the LEFTLAYER’s color not extending all the way down is only a problem if 
you choose to use a the background-color property.  
 
If you need to fix the left layer’s height, we’ll do that in the next lesson). 
 
 
Creating Equal Height Layers (The “Hack”) 
 
* Thanks to ProjectSeven.com for this “hack.”  
http://www.projectseven.com/tutorials/css/pvii_columns/index.htm 
 
*** The Problem: CSS layers (correctly called a <DIV> container) don’t behave like table cells. If you 
create a table with two side-by-side columns, the height of both columns will automatically expand to the 
full height of the tallest one. Each column will be the same height. This does not happen with CSS layers. 
DIVs are separate containers – one doesn’t know what the other is doing.  
 
Problem shown here: http://streaming.smad.jmu.edu/smad404/lessons/css/floatlayout.html 
 
* One solution is to use javascript to fix this problem. The javascript asks the browser to report the 
rendered height of two or more DIVs and uses that information to set each DIV to the height of the tallest 
one – based on a particular tag in each column.  
 
The fix shown here: http://streaming.smad.jmu.edu/smad404/lessons/css/floatlayout-fix.html 
Another example: http://streaming.smad.jmu.edu/smad404/lessons/css/floatlayout-fix2.html 
(with animation). 
 
* Create a new file in Dreamweaver and call it p7_eqCols2_10.js 
* In code view, replace all the other text in the document with this text.  (Copy and paste this into the 
document in code view – making sure you replace all the text there). 



 
p7_eqCols2_10.js 

/*  
  ------------------------------------------------ 
  PVII Equal CSS Columns scripts -Version 2 
  Copyright (c) 2005 Project Seven Development 
  www.projectseven.com 
  Version: 2.1.0 
  ------------------------------------------------ 
*/ 
function P7_colH2(){ //v2.1.0 by PVII-www.projectseven.com 
 var i,oh,h=0,tg,el,np,dA=document.p7eqc,an=document.p7eqa;if(dA&&dA.length){ 
 for(i=1;i<dA.length;i+=2){dA[i+1].style.paddingBottom='';}for(i=1;i<dA.length;i+=2){ 
 oh=dA[i].offsetHeight;h=(oh>h)?oh:h;}for(i=1;i<dA.length;i+=2){oh=dA[i].offsetHeight; 
 if(oh<h){np=h-oh;if(!an&&dA[0]==1){P7_eqA2(dA[i+1].id,0,np);}else{ 
 dA[i+1].style.paddingBottom=np+"px";}}}document.p7eqa=1; 
 document.p7eqth=document.body.offsetHeight; 
 document.p7eqtw=document.body.offsetWidth;} 
} 
function P7_eqT2(){ //v2.1.0 by PVII-www.projectseven.com 
 if(document.p7eqth!=document.body.offsetHeight||document.p7eqtw!=document.body.offsetWidth){P7_colH2();} 
} 
function P7_equalCols2(){ //v2.1.0 by PVII-www.projectseven.com 
 var c,e,el;if(document.getElementById){document.p7eqc=new Array(); 
 document.p7eqc[0]=arguments[0];for(i=1;i<arguments.length;i+=2){el=null; 
 c=document.getElementById(arguments[i]);if(c){e=c.getElementsByTagName(arguments[i+1]); 
 if(e){el=e[e.length-1];if(!el.id){el.id="p7eq"+i;}}}if(c&&el){ 
 document.p7eqc[document.p7eqc.length]=c;document.p7eqc[document.p7eqc.length]=el}} 
 setInterval("P7_eqT2()",10);} 
} 
function P7_eqA2(el,p,pt){ //v2.1.0 by PVII-www.projectseven.com 
 var sp=10,inc=20,g=document.getElementById(el);np=(p>=pt)?pt:p; 
 g.style.paddingBottom=np+"px";if(np<pt){np+=inc; 
 setTimeout("P7_eqA2('"+el+"',"+np+","+pt+")",sp);} 
} 
 
* Save the file p7_eqCols2_10.js in the same folder as the html file that will call on it.  
 
* Open the file called floatlayout-nofix.html created in the previous lesson and re-save it as floatlayout-
fix.html. 
 

floatlayout-fix.html 
<script type="text/javascript" 
src="p7_eqCols2_10.js"></script> 
 
<body 
onLoad="P7_equalCols2(0,'leftlayer','P','rightlayer','P')"> 
 

 Place this in the HEAD of the document. 
 
 
 Place this in the BODY tag. Change 
bold items to: 
 
0 = no animation (change to 1 for 
animation). 
leftlayer = first layer to make equal. 



P = what tag in the layer to apply it to. 
rightlayer = the next layer to make equal. 
P = what tag in the layer to apply it to. 

 
* Save the file floatlayout-fix.html and check it in a browser.  Both the “Left Layer” and the “Right 
Layer” should be equal heights. 
 
* This can be applied to as many columns as needed. 
 
Image Float – (Simple)  
Example: http://streaming.smad.jmu.edu/smad404/lessons/css/eximagefloat.html 
 
* Create a new file in Dreamweaver and call it imagefloat.html 
* Use the image lab.jpg 
 

imagefloat.html 
<style type="text/css"> 
#imgback { 
 background: url("lab.jpg") no-repeat; 
 height: 700px; 
} 
#img { 
 width: 168px; 
 height: 116px; 
 padding: 0; 
 float: left; 
 clear: left; 
} 
</style> 

 
  Background Image 
 
 
 
  <DIV> that specifies width & height of the 
background image 

<table width="750"> 
   <tr> 
      <td> 
<div id="imgback"> 
<div id="img"></div> 
<p  class="medtext">Text that wraps around goes 
here. Notice that it nested inside the imgback div. 
</p>  
</div> 
      </td> 
   </tr> 
</table> 

 
 
  Background Image 
  Empty < DIV> that specifies width & height 
of the background image. 

 
* Save the file imagefloat.html and check it in a browser.   
 
Image Float: Ragged Wrapping – (Sandbagging)  
Example 1: http://streaming.smad.jmu.edu/smad404/lessons/css/exsandbagging.html 
 (The red lines around it are just to show the empty <divs>) 



Example 2: http://www.bigbaer.com/css_tutorials/css.image.text.wrap.htm 
 
* Create a new file in Dreamweaver and call it sandbagging.html 
* Use the image camerawomen.jpg 
 

sandbagging.html 
STEP 1: Place the following into 
the head section of the document. 

<style type="text/css"> 
#imgback { 
 background: url("camerawomen.jpg") no-repeat; 
 height: 132px; 
} 
</style> 

STEP 2: Place the following into 
the body section of the document to 
make the background image shows 
up. 

<table width="750"> 
   <tr> 
      <td> 
<div id="imgback"> 
</div> 
      </td> 
   </tr> 
</table> 

STEP 3: Draw each layer in 
Dreamweaver to conform to the 
variations in the image.  

 
STEP 4:  
In Dreamweaver, “Code View”: 
- Remove these: 
position:absolute; 
- Add these to the layer tags: 

padding:0;  
float: left; 

 clear: left; 

i.e.: Dreamweaver might create this:   
 
<div id="Layer1" style="position:absolute; left:20px; top:46px; 
width:122px; height:16px; z-index:1; padding:0; float: left; clear: 
left"></div> 
 

STEP 5:  #Layer1 { left:20px; top:46px; width:122px; height:16px; 



- Cut and paste the layer tags (such 
as shown in STEP 4) into the head 
of the document in the <style> 
section.  
 
- Change the formatting to look like 
this    
 
 

padding:0; float: left; clear: left; z-index:1 } 
#Layer2 { left:10px; top:65px; width:141px; height:15px; 
padding:0; float: left; clear: left; z-index:2 } 
#Layer3 { left:10px; top:84px; width:132px; height:17px; 
padding:0; float: left; clear: left; z-index:3 } 
#Layer4 { left:10px; top:102px; width:137px; height:17px; 
padding:0; float: left; clear: left; z-index:4 } 
#Layer5 { left:10px; top:121px; width:140px; height:19px; 
padding:0; float: left; clear: left; z-index:5 } 
#Layer6 { left:10px; top:140px; width:145px; height:31px; 
padding:0; float: left; clear: left; z-index:6 } 

STEP 6: Place the following text 
into the document between the tags 
in red. 

<table width="750"> 
   <tr> 
      <td> 
<div id="imgback"> 
<div id="Layer1"></div> 
<div id="Layer2"></div> 
<div id="Layer3"></div> 
<div id="Layer4"></div> 
<div id="Layer5"></div> 
<div id="Layer6"></div> 
<p>This is the text that will raggedly wrap around the background 
image etc. etc.</p> 
</div> 
      </td> 
   </tr> 
</table> 

 
* Save the file sandbagging.html and check it in a browser.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setting up Dreamweaver for CSS 
 
* Dreamweaver automatically uses CSS for text, instead of the old-fashioned HTML font tags.   



 
* Create a new file in Dreamweaver and call it dwcsslesson1.html 
* Edit > Preferences > (“General” category) 
 - See what the Font and Size boxes look like in the Properties Inspector with it checked and  
               unchecked. 
 

_X_ Use CSS instead of HTML tags 
 

 

___ Use CSS instead of HTML tags 
 

 
 
 

CSS in Dreamweaver 
 
Create Styles with an “Internal” Style Sheet (Using the Properties Inspector) 
 
* Create a new file in Dreamweaver and call it dwcssinternal.html 
* Type some text on the screen and select it with your mouse 
* Properties Inspector: Size > 24 

 - This creates a style called style1 
   - Rename this style by clicking on the drop-down arrow next to the “Style” box 

    
 

   - Call it large24 
 - You can now use this “style” on other text.  



 
* In Dreamweaver: Code View (Notice this CSS) 
    

<style type="text/css"> 
.large24 {font-size: 24px} 
</style> 

 
* Save the file dwcssinternal.html and check it in a browser. 
 
Create Styles with an “Internal” Style Sheet (Using the CSS Styles Tab) 
 
* Open the file dwcssinternal.html  
* Design Panel > CSS Styles tab 
* Click on the “New CSS Style” button 

 
* Give it the name .medium18 
* Select the “This document only” box 
to make an Internal style sheet 
     - Click OK 
 

 
 
 
 
* Create the style as such   
      - Click OK 

 
 
* Type some more text on the screen. 



* Properties Inspector > Style > Apply the new style .medium18 
 
Editing the Style 
* Design Panel > CSS Styles tab 
 - Click on the style you want to edit 

- Click on the “Edit Style Sheet” button 

 
 
Further Adjustments to the CSS 
 
* Design Panel > CSS Styles tab: Select the .medium18 style to adjust it. 
* Tag Inspector Panel > Relevant CSS tab 
 
 

 
 
* Experiment with the settings and check the code in Code View. 
* Save the file dwcssinternal.html and check it in a browser. 
 
Create Styles with an “External” Style Sheet 
 
* Create a new file in Dreamweaver and call it dwcssexternal.html 
 



Creating or Attaching a New Style Sheet 
* Design Panel > CSS Styles tab 
 
* Click on the “Attach Style 
Sheet” button 

 
* File/URL: Type  
stylesheet.css 
* Add as: Link 
     - Click OK 

 
 
*** NOTE: To Attach an Existing Style Sheet 
* This allows us to create a new file, but attach a style sheet that we’ll use for all of the pages on the site 
* Design Panel > CSS Styles tab 
* Click on the “Attach Style Sheet” button, then browse to the .css file you want to attach 
 
Creating a Style Using the External Style Sheet 
* Design Panel > CSS Styles tab 
* Click on the “New CSS Style” button 
* Use the setting below to use the External style sheet: 

 
 
* Create the .small12 style style using the following settings: 
 - Font: Arial, Helvetica, sans-serif 
 - Size: 12 
* Create some text in the file dwcssexternal.html, select it, and apply the .small12 style 
* Save the file dwcssexternal.html and check it in a browser. 
 
 



Using “Class” in Dreamweaver 
 
*** For the next examples, we’ll place the styles in an Internal Style Sheet 
 
* Recall that there are two ways to apply “Class” selectors: 

1. Tags 
- Tag maintains its original properties, but ADDS properties to the tag 

2. Selections of Text  
- Creates a <span> tag 

 
* Create a new file in Dreamweaver and call it dwcssclass.html 
* Click on the “New CSS Style” button 
 - Selector Type: Class (as below) 

 
 
* Create a style called .large24 using the following settings: 
 - Font: Arial, Helvetica, sans-serif 
 - Size: 24 
 - Weight: bold 
 
* Type a few lines of text, and create a paragraph break between each 
* Apply the .large24 style to both a tag and a selection of text, as below 
 

1. Tags 
 

* Use the “Tag Selector to select a <P> tag: 
- (Make sure the document window is 
maximized in order to see the “Tag Selector”). 
* Apply the Large24 style: 
                         

 

2. Selections of Text <span> 
 

* Select some text on the screen: 
* Apply the Large24 style: 
 
 
 

 

 
<p class="large24">This is an example of 

 
<p>This is a CSS page. <span class="large24">This 



applying CSS to an entire tag. In this case, all 
of the text is contained within the same 
paragraph. </p> 

example shows how to apply CSS to a 
selection.</span> All of this text is part of the same 
paragraph. 

 
* Save the file dwcssclass.html and check it in a browser. 
 
Redefining Tags in Dreamweaver 
 
* Create a new file in Dreamweaver and call it dwcsstag.html 
* Click on the “New CSS Style” button 
 - Selector Type: Tag (as below) 
 

 
 
 - The drop-down menu allows you to select tags, or you can type in your own. 
* Tag: Using the drop-down menu, select h6 
 - Click OK 
* Use the following settings: 
 - Font-family: Arial, Helvetica, sans-serif 
 - Font-size: 10px 
 - Font-weight: bold 
 
* Create some text in the file dwcsstag.html, select it, and apply the .h6  
* Save the file dwcsstag.html and check it in a browser. 
 
 
Advanced CSS Selectors in Dreamweaver 
 
* Recall that there are 4 ways to utilize Advanced CSS Selectors: 

1. Groups of Tags 
2. Contextual Selectors 
3. Link Pseudo Class Selectors  
4. IDs 

 
1. Groups of Tags 
* Create a new file in Dreamweaver and call it dwcssgroup.html 
* Click on the “New CSS Style” button 
 - Selector: (Use the values below) 
  - Separate the tags with COMMAS 



 - Selector Type: Advanced (IDs, contextual selectors, etc) (as below) 

 
 
 - Click OK 
* Use the following settings: 
 - Font-family: Arial, Helvetica, sans-serif 
 - Font-weight: bold 
 - Color: #CC6600 
 
* Create some text in the file dwcssgroup.html and apply the following tags .h1, h2, h3 and h4 

 
 
* Note that all the headers take on the properties defined in the style, while maintaining the original 
header properties. 
* Save the file dwcssgroup.html and check it in a browser. 
 
2. Contextual Selectors 
* Create a new file in Dreamweaver and call it dwcsscontext.html 
* Click on the “New CSS Style” button 
 - Selector: (Use the values below) 
  - Separate the tags with SPACES 
 - Selector Type: Advanced (IDs, contextual selectors, etc) (as below) 
 



 
 
 - Click OK 
* Use the following settings: 
 - Font: Courier New, Courier, mono 
 - Color: #339900; 
* Using the file dwcsscontext.html, create a table and place a link inside a table cell <td>.  
 

 
 
* Save the file dwcsscontext.html and check it in a browser. 
 
3a. Link Pseudo Class Selectors (Redefining Links) 
* Allows you to redefine the <a> tag, along with visited and active link colors 
* Allows a rollover effect with a:hover 
 
* Create a new file in Dreamweaver and call it dwcsspseudo.html 
* Click on the “New CSS Style” button 
 - Selector: a:link 
 - Selector Type: Advanced (IDs, contextual selectors, etc) (as below) 
 

 
 



 - Click OK 
* Use the following settings: 

- Font-family: Arial, Helvetica, sans-serif 
 - Font-size: 12px 
 - Color: #0000FF 
 - Text-decoration: none 
  - Click OK 
 
* Repeat these steps for the following: 
a:visited 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 
 color: #4444FF; 
 text-decoration: none; 
a:hover 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 
 color: #0000FF; 
 text-decoration: underline; 
a:active 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 12px; 
 color: #4444FF; 
 text-decoration: none; 
 
* Save the file dwcsspseudo.html and check it in a browser.  Make sure you roll over the link.  It should 
look like below: 
 

 
 
 
3b. Link Pseudo Class Selectors (Different Links for Different Purposes) 
* Allows you to create different types of links for different purposes 
 



* Using the file dwcsspseudo.html, re-save it as dwcsspseudo2.html 
* Click on the “New CSS Style” button 
 - Selector: a.lesson:link 
 - Selector Type: Advanced (IDs, contextual selectors, etc) (as below) 
 

 
 - Click OK 
* Use the following settings: 

- Font-family: Courier New, Courier, mono 
 - Font-size: 11px 
 - Color: #00DD00 
 - Font-weight: bold 
 - Text-decoration: none 
  - Click OK 
 
* Repeat these steps for the following: 
a.lesson:visited  
 font-family: Courier New, Courier, mono 
 font-size: 11px 
 color: #00DD00 
 font-weight: bold 
 text-decoration: none 
a.lesson:hover  
 font-family: Courier New, Courier, mono 
 font-size: 11px 
 color: #00AA00 
 font-weight: bold 
 text-decoration: underline 
a.lesson:active  
 font-family: Courier New, Courier, mono 
 font-size: 11px 
 color: #00DD00 
 font-weight: bold 
 text-decoration: underline 
 
* Create a link on the page dwcsspseudo2.html 
* To apply the “lesson” style to the link, select the text and use the Properties Inspector as below: 
 



 
 
* Save the file dwcsspseudo2.html and check it in a browser.  You should have two different link styles.  
Make sure you roll over the links.  They should look like below: 
 

 
 
 
4. IDs 
* Starts with a pound sign (i.e. .#header) 
* Used to identify objects on a page 
* Can only be used once on a page 
* Often used to ID layers or images so they can be tracked 
 
* Create a new file in Dreamweaver and call it dwcssid.html 
* Click on the “New CSS Style” button 
 - Selector: (Use the values below) 
  - Start the style with # (POUND SIGN).  Call it #header 



 - Selector Type: Advanced (IDs, contextual selectors, etc) (as below) 

 
 
 - Click OK 
 - Create the style by changing the font, size, weight and color 
 
Applying the ID to a tag 
* Create some text on the file dwcssid.html 
* Using the “Tag Selector”, right click on the tag to select the #header ID 
 

 
 
* Save the file dwcssid.html and check it in a browser.   
 
Editing the CSS File vs. Using the Dreamweaver Panels 
* You may find it easier to make changes to the CSS file by simply opening the file and typing in changes 
of copying and pasting.   
 
* To open a stylesheet, just double-click on it in the CSS Styles panel 
 



 
 
 
 
 
 
 
 
 
 

CSS at Work (Sample Applications) 
 
Creating Layers for Positioning 
 
* Create a new file in Dreamweaver and call it layers.html 
 
* Insert Bar > Draw Layer Icon: Draw a layer box in the upper left hand corner, as below 
 



 
 
* Click inside the Layer 
* Type some text for links in the box, as below: 
 

 
 
* Click on the Layers Handle to select it (see below) 
* Properties Inspector: Notice the name of the layer (Layer ID) is Layer 1 
 - You can change the layer name if you desire 



 
 
 
* Draw another Layer and place the image called lab.jpg inside it: 

 
 
* Click on the edge of the layer and resize the layer using the layer handles 
* Finally, draw one more layer with some text 

 
 
 
 



* Save the file layers.html and check it in a browser.   
 
Converting Layers to Tables and Tables to Layers 
* Modify > Convert > (Select the appropriate option) 
 
Positioning Using an External Style Sheet (Using ID) 

This allows you to create a layout that you can apple to every web page.  And, if you need to make 
a change to the layout, you make it in the external file and it affects all the pages on your site. 
 
OPTION 1: (Automatic manipulation) 
* Simply create all the layers (and other style information) in the document, then do the following: 

- File > Export > CSS Styles… 
- Pick the style sheet where you want to put the style information. 

 
OPTION 2: (Manual manipulation) 
* Using the file layers.html, rename it layersexternal.html 
* Link the file layersexternal.html to an external style sheet file you call stylelayers.css 
 
* Once you have designed the Layer layout you want for your pages, find the following tag in the file 
layersexternal.html:  
 
 
<div id="Layer1" style="position:absolute; left:13px; top:12px; width:184px; height:128px; z-index:1"> 
 
*** z-index:1 (This indicates the stacking order of multiple layers.  Higher numbers are on top). 
 
* Copy and paste the text to stylelayers.css, and alter it as so: 
 
#Layer1 { 

position:absolute;  
left:13px;  
top:12px;  
width:184px;  
height:128px;  
z-index:1 

} 
 
* Replace the tag above in your layersexternal.html file with: 
 
<div id="Layer1”> 
 
 
* With both files in “Code View” on your screen, change the position of the layer in layersexternal.html, 
and notice it changes the position information in stylelayers.css, as below 
 



 
 
Show/Hide Layers 
Example 1: http://streaming.smad.jmu.edu/smad404/lessons/css/showhide.html 
Example 2: http://www.drsteveanderson.com/canals/map.html 
 
 In this lesson, we will start with only Layer 1 showing, and allow the user to show the other layers 
by clicking on the links in Layer 1.  
 
* Use the file called layers.html and rename it showhide.html 
* Design Panel > Layers Tab >  

 
 
* Layer 1: Select the Link 1 text (as below) 
* Properties Inspector: Place a pound sign in the “Link” field, as below 
 

                         



* Tag Inspector Panel > Behaviors Tab > Click on the + sign 
 - Show-Hide Layers 
  - Use the settings below: 

 
 
* Do the same series of steps for Link 2 with the following settings: 
 - layer “Layer1” 
 - layer “Layer2” (hide) 
 - layer “Layer3” (show) 
 
* Save the file showhide.html and check it in a browser.   
 
*** NOTE: You can also make the Layers appear onMouseOver, instead of onClick.  
 
 - Tag Inspector Panel > Behaviors Tab > Use the drop-down menu to change the setting, as below 
 

 
 
 
 
 
 
 
 
 
 



 
 

**** THE SECTION THAT FOLLOWS IS UNDER DEVELOPMENT **** 
 
Drag Layers and Timeline Animation 
 
*** For this lesson, we’ll create a simple Tic-Tac-Toe game where the words animate and the layers can 
be moved by the user. 
 
* Create a new file in Dreamweaver and call it game.html 
* Use the image lab.jpg 
 
* View > Grid > Show Grid 
* View > Grid > Snap To Grid 
 
* Working With Layers 
* Design Panel > Layers Tab 
 - Make sure “Prevent Overlaps” is unchecked 
 
* Insert Bar (Layout Tab) > “Draw Layer” icon 
 - Draw a small box toward upper left corner (leave some space from top) 

- Left-click inside the “Layer Box” 
 
* Insert Bar (Common Tab) > “Insert Image” icon 
 - Select the image “board.gif” 
* Left-click on the Layer’s handle (top left) 
* Properties: Layer ID: “board” (this names the layer) 
 
* Working with the Timeline 
* Windows > Others > Timelines 
- Left-click on the handle of the “board” layer, drag it to the Timeline – Channel 1 
 - Drag the right keyframe to frame 30 
- Properties: (Check the Autoplay box) 
 
 
** Animating “Tic-Tac-Toe” 
- Objects Palette: “Draw Layer” icon 
 - Make the layer to the top right of the board 
- Objects Palette: “Insert Image” icon 
 - Select the image “tic.gif” 
- Left-click on the layer’s handle 
- Properties: Layer ID: “tic”  
 
* DO THE SAME PROCEDURE FOR  “TAC” and “TOE” 
 
- Drag the “tic” layer to the Timeline – Channel 2 
 - Drag the right keyframe to frame 30 
 - Left-click on frame 15 of Channel 2: Add Keyframe 
- Set locations for frames 15 and 30 to animate “tic” to an area above the board. 



 
* DO THE SAME PROCEDURE FOR  “TAC” and “TOE” USING THE FOLLOWING: 
 Tac: First frame at frame 5, keyframe at frame 20 
 Toe: First frame at frame 10, keyframe at frame 25 
- Set locations for frames to animate “tac” and “toe” to final positions 
 
 
******** WORKED ON FROM HERE DOWN ************* 
* Creating the Moveable Layers 
* Insert Bar (Layout Tab) > “Draw Layer” icon 
 - Draw the layer box just below the starting positions of “tic-tac-toe” 
* Insert Bar (Common Tab) > “Insert Image” icon 
 - Insert “x.gif” 
* Left-click on the layer’s handle 
* Properties Inspector: Layer ID: “x1” 
 
* Left-click on the image inside the layer (not on the layer’s handle) 
* Tag Inspector Panel > Behaviors Tab 
 - Click on the + button > Drag Layer 
  - Layer: layer “x1” 
  - Movement: unconstrained 
  - “Get current position” 
  - Snap if within 20 pixels of Drop Target 
 
** FOLLOW THE PREVIOUS STEPS (“Placing Xs and Ox”) FOR 4 MORE Xs 
- Layer ID: x2 
- Layer ID: x3 
- Layer ID: x4 
- Layer ID: x5 
 
** DO THE SAME FOR ALL THE Os 
 
 
 
** Dragging the X and O Layers to the Timeline 
Drag the x1 Layer to Timeline - Channel 5 
Drag the x2 Layer to Timeline - Channel 6 
Drag the x3 Layer to Timeline - Channel 7 
Drag the x4 Layer to Timeline - Channel 8 
Drag the x5 Layer to Timeline - Channel 9 
Drag the o1 Layer to Timeline - Channel 10 
Drag the o2 Layer to Timeline - Channel 11 
Drag the o3 Layer to Timeline - Channel 12 
Drag the o4 Layer to Timeline - Channel 13 
Drag the o5 Layer to Timeline - Channel 14 
 
- Drag the last keyframe of each channel to frame 30 



 
- File > Save 
 
- Go to a browser and open game.html 
 
 
 
 
 
 

Dreamweaver Extensions 
 
 
Persistent Layers 
 
 


